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Topic 5

Working with Images

Make your Web page more interesting by adding photos,
graphics, animation, video, and other visual elements. This
chapter shows you how to insert and format these elements.
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Topics: Working with Images

Insert an image into a Web page
Crop an Image

Resize an Image

Open an Image in an Image Editor
Add a Background Image

Change Text Colors

Create a Rollover Image

Insert a Video from YouTube




2.® = You can find free clip art images on the Web at
http://office.microsoft.com/en-us/images/
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Source: Simplified Creating Web Pages with HTML by Sherry Willard Kinkoph
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| o * JPEG or JPG which stands for Joint Photographic
Experts Group, supports 24 bit color, allowing for
millions of colors.

The JPEG format i1s commonly used for complex
Images, such as photos or graphics that used
millions of colors and feature lots of detail.

= JPEG Iis not a good choice for simple artwork
because It results in a larger overall file size, which
In turn , takes longer to display on Web pages.

TEREY"

Source: Simplified Creating Web Pages with HTML by Sherry Willard Kinkoph



Images, such as simple graphics utilizing basic
shapes and lines, and logos.

= |f you image or graphic contains few colors and
not a lot of detail, GIF is a good file format choice.

Source: Simplified Creating Web Pages with HTML by Sherry Willard Kmkoﬁ&' a™




= The PNG format, which stands for Portable
Network Graphics, offers rich color support and
advanced compression schemes.

= |t 1s good choice for any kind of images, from
graphics to photographs.

= PNG supports 24-bit color, like JPEG, but greater
®  file compression.

= Choose PNG if you intended audience most likely
uses a new browser version.

Source: Simplified Creating Web Pages with HTML by Sherry Willard Kinkoph
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3> Understanding Web Page
» Images

' : Downloading Considerations

= Browsers must first download an image before
users can view it on the Web page.

= Large images can take a long time to display,
especially with slower Internet connection speeds.

= For this reason, you need to consider the overall
file size of an image when deciding whether to add
It to a Web page.

= Do not populate your page with many large
pictures, or the download time will be excessive.

Source: Simplified Creating Web Pages with HTML by Sherry Willard Kinkoph



) » " You can Insert different types of images into your
Y & Web page, including clip art, digital camera
Images, and scanned photos.




. Click to mouse position where you want to insert
the image.

. Chlick Insert

. Click Image

Note: You can also click Image [ . button in the
Common Insert panel

. Click =] and select the folder that contains the
Image

. Click the image file that you want to insert into
your Web page.
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| o Insert an Image into a Web
» Page

19 -
| o ¥ Insert an Image into a Web page
® 6. Click OK

Note: Alternative text appear in the code behind an image and
displays only if the image is not visible.

Alternative text is especially important for the visually
impaired visitors who use screen readers to “read” Web
pages to them.

: 8. Enter a URL for a longer description, if available.
2.® 9 Click OK
9
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Insert an Image into a Web
a Page
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S Insert an Image into a Web
8 » Page
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° % Insert an Image into a Web page

Select Image Source

Server...

Select file name from: (%) File spstem

) Data sources

Image preview

s

Look in: | =3 image

[he Select Image
Source dialog box
\ppears.

@diner.png
@mapdirectinns.png
Ial:n.lrg|er3.|:|n|;| @rullcantact.png
@buttoncuntact.png @rulldirections.png
IEI:uuI:tu:nu:lireu:tiu:ul'us.|:un|;| @rullfeedback.png
@huttunfeedback.png @rullhame.png
@buttnnhume.png @rullhnurs.png
IaI:ul.lttu:nl‘uuurs.|:n|;| @rullmenu.png

@buttnnmenu.png 5

@burgerl .png
@hurgerZ.png

o panyLogo.png

File namme:

A preview of the
Image appears.

798 2 125 PNG, 30K /

T

» | [ Cancel

| ComparyLogo.png

Files of twpe: | Image Files [*.qif.*.jpg;” jpea:”. pna;” pad)

0

IRL: | image/CompanyLogo.png h

Felative to: directionz. html

Change default Link Relative To in the zite definition.

Freview ima

You can insert an image that
exists at an external Web
address by typing the address
into the URL field.
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' Insert an Image into a Web
s Page

2% Insert an Image into a Web page

- ® | Alternative text appear in the ianz.lag hegessibility Attibutes
@ | code behind an image and E— /
® displays only if the image is not| [ woe=sm el &——¢g o
- visible. P U0 S
- . objects, change the Accessibility preferences,
~ @
| code | <= spit | tive view || ) Tie: |LMC Brentwond Buraer | I, (@) FE, @, | B2 2 checkPage
8

The image appears
where you
positioned your
cursor in the Web

page.

To delete an image,
click the image and
press <Delete>.
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Crop an Image

# " Youcan trim, or crop, an image by using the
Crop tool and dragging the crop handles to
adjust how much of the image you want to
show.

an external image-editing program, as it
physically crops the image file.
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! » Crop an Image

. Click an image to select it.
. Click the Crop tool =t
. Click OK

. Click and drag the black, square handles to
define the area that you want to crop.

. Double-click inside the crop box.
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P Crop an Image
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Dreamweaver, X

- The action you are about ko perfarm will permanently
\‘!‘) alter the selected image. ¥ou can undo any changes
wou make by selecting Edit = Unda,

_—-——'—'D Don't show me this message again.
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ou can turn off this
warning by clicking
the check box.
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Crop an Image e

® Should I edit images in Dreamweaver or
use an external graphics program?

Adobe has added the Crop and other basic editing
tools to make working on a Web page faster and
easier.

If you need to do a simple crop, the Crop tool is
faster than opening the image in an image-editing
program such as Adobe Fireworks or Adobe
Photoshop.

However, If you want to save a copy of the original
before you make the crop, or do other image editing,
~® then you need to use a dedicated image-editing

+® program
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Resize an Image

= You can change the display size of an image
without changing the file size of the image.

= You can do this by using a percentage or a
pixel size, or by clicking and dragging the
corner of the image.

NOTE: Pixels are tiny, solid-color squares that make up a
digital image. When you specify a site in pixels, you
are using a very small unit of measurement.




Resize an Image

: :W Resize Using Pixel Dimensions

1. Click an image to select it.

. Type the desired width of the image, either In
pixels.

. Press <Enter>

. Type the desired height of the image In pixels
Or as a percentage.

. Press <Enter>




' p Resize Using Pixel or Percentage
Dimensions
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' p Resize Using Pixel or Percentage
Dlmensmns
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1 s Resize an Image
§ - % Click and Drag to Resize

= ® 1. Click an image to select it.
. Drag one of the handles at the edge of the image

Note: To resize the image proportionally, press and hold
down the shift as you drag a corner
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s Resize an Image

.W Click and Drag to ReS|ze
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and hold down <Shift>
as you drag a corner.
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’ » Resize an Image

: :W Reset the Image to the Original
s Size

=® 1 Click the image to select it.
(92 Click Reset Size in the Property inspector.
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1 Resize an Image to the
Yo
* ™ Original Size
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o Resize an Image e

What is the best way to change the
dimensions of an image on a Web page?

Although you can change the pixel dimensions or
click and drag an image in Dreamweaver to stretch
or shrink it on the Web page, this does not actually
resize the 1image’s true dimensions.

Click and dragging an image may cause distortion
or alter proportions.

A Dbetter to resize an image Is to open it an image
editor such as Adobe Fireworks or Photoshop, and
change its actual size.




=9

| o Open an Image In an Image
» Editor

= Adobe designed Dreamweaver to work with
multiple image programs so that you can easily
open and edit the images while you are working
on your Web page.

sophisticated image-editing programs that are
designed to make many changes to an image.

NOTE: Although you can use any image editor. Fireworks and
Photoshop are integrated with Dreamweaver because Adobe makes
all three programs




Note: You can open any image in an external
Image editor from within Dreamweaver

. Click Photoshop in the Property inspector.

. After making your changes, click File
. Click Save As

. Save the image with the same name and format,
replacing the original image.




Image

What can you do in an image-editing
program?

A program such as Adobe Fireworks or Photoshop
allows you to edit and combine images to create
almost anything that you can image.

If you have Fireworks installed, than you can open
It to edit an image directly from Dreamweaver.

In the Property inspector, click the Edit/ Fireworks
L_ogo button.




Add a Background Image

= You can Insert an image into the background of

a Web page to add texture and depth to your
design.

= Background images appear behind any text or

Images that you are on your Web page and are
repeated across and down the Web browser
window unless you specify otherwise.




F o ¥ Add a Background Image
. Select Modify and then Page Properties
. Click Appearance (CSS)
. Click Browse

~ Click = and select the folder that contains the
background image file

. Click the background image that you want to
Insert.

. Click OK.




: :W Add a Background Image

= ® /. Click here and choose an option to specify

=-®  whether or not the image should repeat across
_ 9 and down the page.

=® 35 Click OK
3




§ - Add a Background Image e

What types of images make a good
backgrounds?

Textures, subtle patterns, and photos with large
open areas all make good background images.

It Is Important to make sure that the image does not
clash with the text and other content in the
foreground or overwhelm the rest of the page.

Using an image that tiles seamlessly is also a good
Idea so that your background appears to be one
large image that covers the entire page.

Fireworks includes a number of features that can
help you create a background image.




§ - Add a Background Image e

Are backgrounds always patterns?

Although many backgrounds repeat a pattern of
some kind, a background image can also be an
Image that is big enough to fill the entire screen.

Because a background image tiles, a vertical image
creates a stripe across the top of the page, and a
horizontal image creates a left-hand stripe




Change the Background Color

= You can add color to your Web pages by
changing the background color.

= Dreamweaver offers a selection of Web-safe
colors that are designed to display well on all

computer monitors.




. Select Modify and then Page Properties
. Click Appearance (CSS)

. Click the Background color to open the color
palette

. Click a color from the menu using the
Eyedropper tool.

. Click OK




'+ Change the Background Color
%9 Change the Background Color
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Change Text Colors

= You can change the text color for the entire
page using Dreamweaver’s Page Properties.

= When you alter page and text colors, make
sure that the text is still readable.

= In general, light text colors work best against
a dark background and dark text colors work
best against a light background.




. Select Modify and then Page Properties
. Click Appearance

. Click Text color to open the color palette.
. Click a color using the Eyedropper tool.
. Click OK




3 Change Text Colors
® Nerw Change Text Colors
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A fun, friendly and cozy diner pride ourselves in using the best
ingredients in all of our savory and delicious sirloin steak burgers.
Whether you're craving a tasty or filling specialty steak burger with
your favourite trimmings, we've got you covered!
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Create a Rollover Image

= Rollover images are designed to react when
someone rolls a cursor over them.

They are commonly used in navigation bars and
other links, but they can also be used to add a
little surprise to your pages

= A rollover effect can be subtle or dramatic,
depending on the difference between the two
Images that you use in the rollover, but both
Images must be the same size.




£ ® Create a Rollover Image

,\@ Create a rollover image

. Position the pointer where you want to insert the
rollover image

. Select the Insert tab
. Select Rollover Image




< Create a Rollover Image

2% Create a rollover image

File Edit View Insert Tools Find Site Window Help

directions.html*
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Directions S

Animated Composition
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Rollover Image




£ ® Create a Rollover Image

,W Create a rollover image

. Type an identifying name for scripting
purposes.

. Click Browse and select the first image

. Click Browse and select the second image.
. Type an alternative text

. Click on the OK button
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5 Create a Rollover Image
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8 3 v Create a rollover image for the

navigation bar
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» Create a Rollover Image e

How does the rollover image work?

The interactive effect of a rollover image requires
more than HTML Dreamweaver creates this effect
by using a scripting language called JavaScript.

JavaScript Is used for many kinds of interactivity,
from Image swaps to pop-up windows.

JavaScript i1s more complex then HTML code.

Dreamweaver includes many other JavaScript
features in the Behaviors panel.

To see what other kinds of behaviors are available,
use the Window menu to select Behaviors.




Insert a Video from YouTube

= One of the easiest ways to add video to your Web
pages Is to embed the video from the popular
video site YouTube, www.youtube.com

= You can embed almost any video on YouTube

Into your Web site by copying and pasting a little
code from YouTube into your site.



http://www.youtube.com/

rollover image
. Click Insert

. Click Image Objects

. Click Rollover Image

. Type an identifying name for scripting purposes.
. Click Browse and select the first image

. Click Browse and select the second image.




